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23.03. mSupply client / server installation
part 3

- These steps need to be carried out after completing
/1 the steps described in:

£22-5 20.01 mSupply client/server installation part 1
20.02 mSupply client/server installation part 2

Installing mSupply Server software
If you are upgrading from a previous version...

If you are upgrading from a previous version of mSupply, first perform a data backup:

e With mSupply server open as an application click on File> Backup.... This will generate a
backup file of your current data with file extension .4bk.

e Copy this file to at least one safe place, e.g. USB drive, a cloud service such as Dropbox.

e Continue only when the .4bk file has completed transfer to the remote location.

Moving from pre v3.50?

v3.50. If you are upgrading from a pre v3.50 installation of
mSupply, Sustainable Solutions will need to convert your
data so that it can be read by mSupply versions after v3.50.
This conversion process is provided free of charge.

0 There was a major upgrade of mSupply's internal structure in

Obtain and run the mSupply Server installer

The client/server version of mSupply has two installers:

e One installer, with the word Server in the title, is used
to install the mSupply Server software on a single

ﬁ server computer.
e The other installer, with the word Client in the title,

is used to install the mSupply Client software on as
many computers as you wish including on the server
computer. You will be limited in how many clients can
connect at any one time by the server licence you
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ﬁ have purchased.

. You must be logged on as Administrator to install mSupply
L. . Server with the correct permissions. Please consult your IT
support staff if you require assistance to achieve this.

Once you have obtained the mSupply Server installer file, double click it to install. Here is what the
mSupply server installation window should look like:

¥, msupphy Server Setup X

Fs

Installation Folder
Where would vou ke mSupply Server to be installed?

The software will be nstalled in the folder ksted below. To select a different location, ether type in a
new path, or click Change to browse for an esisting folder.

Install mSupply Server to;

C:\Program Files\mSupplyhmSupply Server Change...

Space required: £41.1 ME
Cpace available on selected drive: 88066 GE

£ Back Mest » Cancel

e You may be asked by the OS whether 'you want to allow this app to make changes to your
device?'. Click Yes

e At the mSupply Server Setup Welcome screen, click Next

e To proceed with the installation, you will need to click on the 'l agree to the terms of this license
agreement' radio button and click Next

» Unless you have good reason to do otherwise, don't change the installation folder, and click
Next

e Unless you have good reason to do otherwise, don't change the Shortcut folder, and click Next

e At the Ready to Install window, click Next

e After some time (minutes!) you will be shown the Installation Successful window. Click
Finish
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What is installed where:

We strongly recommend you do not change the default installation directories, which are as follows:

e mSupply Server: C:\Program files\mSupply\mSupply Server
e mSupply Client (see Installing mSupply Client below): C:\mSupply Client

mSupply Server installer also installs the following files and folders:

[ .,||.-|1

—
Q__ j-vl ¥ Carmputer ® Local Disk (C5 » Program Files » mSupply » mSupply Server B reparts » w |y Seorch reparts -
e

File Edit ‘Vaew Tool: Help

Organize - Include in library = Share with, - Mew folder - [ [
MSBuild “  Mame ' Date moadified Type g
o msupply
sn
a maupphy Server
PR [¥5_Store
4d Extension:

. Buctive_rermote_syne_site.pprareP
ZUI-IFNIEFU a backorder_summan: 40R 4
_‘Jr' \.f-: Components B backorder_surnrmanye_groupby_narme.dge
Plugins =) bed_occupancy_rate dgr

B bet_bonus_by_cust_tot 40R
= bet_bonus_by_custamer. 4R
=i bet_discount QR

= bet_donation.£0R

&= bet_donation_by_name 40R

reparts
Resources

Server Databasze
UpgradedDClient

Meell Connect

Starting the Server for the first time

e You are ready to create a new mSupply data file, or
you have one to load.

0 There is no point in carrying out the following steps unless:

Run mSupply Server

/> We need to run mSupply Server as an application until all configuration is completed.
! . Don't run as a Service now as some configuration functionality is not enabled when run
as Service.

Sometime it has been useful to allow the mSupply.exe to run as Administrator by default. This gives
the application the right to modify data in folders that may have been unknowingly restricted by
operating system.

View the mSupply.exe file inside the mSupply installation folder. View properties then Compatibility
tab and set the file to always Run this program as an administrator. View the image below for better
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guidance.

Mame

Components
Licenses
Matnee Components
Plugins
reports
Resources
Server Database
UpgradedDClhent
4 mSupply.ee
% 4D Compaler.dil
4 4Dlibzip.dll
< 4DMsg.di
& 4DSLl.dN
4 Dbl
4 codeeditor.dll
= DB4D.dN
4 Graphics.dil
= GuLdl
& hitpserver.dil
[ icu.dll
% Kernel.dil
 KenellPC.dll
4 languagesyrtax.dil
4 LDAPCemponent.dil
4 libeay3z.di
} libhunsgell Il

Date rmodified Type Size
00 1%:03 File fiolder
12/05/2020 19:05 File fiolder
#+ mSupphy.exe Properties >
Gereral  Compatibiity Secudty Delsls  Previous Versions
I this program isn working camectly on this vension of Windows
try unring the compatibiity troubleshooter.
| Pun compatibilty troubleshoster |
Howe do | choosa compatibilty seiling: manualy? SE50KE
S4H KR
Compatibiity mode 117 KB
DMManﬂmm{m o
7 KE
Windows B -
24 KB
BD KB
Selings 397 KB
Reduced calar mode
£111 KB
Brbkt (296) color 2185 KB
Rurn in 640 x 480 scresn meachution 2219 KR
[] Dizable display scaling on high DFI & 505 KB
] Run this program as an administrator 3850 KB
21084 K
352 KB
258 KB
Change settings for &l users 43T KB
624 KB
0K Cancal Poply A KB

We need to run the mSupply Server software as Administrator.

Find the mSupply Server executable (C:\Program files\mSupply\mSupply
Server\mSupply.exe), right-click on it and select Run as administrator

Open
Open file location

El‘ Run as administrator ]
Troubleshoot compatibility
Pin to Start

@ Upload to MEGA (1 file)

ol Edit with Motepad++
Scan with F-PROT Antivinus
Pin to Taskbar

Send to "

Cut

Copy

Create shortout
Delete

Fename

Properties
T

You will then be presented with the following dialogue box:
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[ =

Mo data file was found for the database "mSupply.4DC". Do you want to
open an existing data file or to create a new data file?

A 40 database needs this file to store its data,

| Cancel | [ Create 1| Open

Click Create to create a new data file or Open to choose an existing data file. The below image
shows an existing data file.

&o Select 2 4D Dats File ==
« "\,,-f'l‘?l <« My Dacuments » mSupply_data » sercer_data[0010] » data_file » - |+¢ || searen data_fils L
Organize * Mew folder == » [ ﬂ

maupply i

Documents library

) Arrange by:  Folder =
data_file

maupply Server Migeria
a mupply_data
Axios server 110321 Mame
axios_data temporary files
Axios_foundation 5 server_data, ddd
Kiribati
Kiribati latest data
nrms 0L
NS _mSupply_data[0078]
nrms_wl2_data
nrh datafile
4 server_data[0010]

4 data_file

m

ermporary files

Preferences - |74 m b

File name: » |40 DataFile (“ddd*data)  v|

l Cpen l | Cancel |

Since Windows version 1803 and following, there can be
issues with permissions to access folders located in
individual user folders such as under My Documents.

I Therefore, it is now highly recommended to save your data
file in the folder: C:\ServerName mSupply data
replacing ServerName with the mSupply server (site) name,
eg. C:\Hagen AMS mSupply data.
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You may get a question from the Windows Firewall requesting permission for mSupply to
communicate through the Firewall.

@ Windows Security Alert >

@ Windows Firewall has blocked some features of this app

Windows Firewall has blocked some Features of 4D Server on all public and private netwaorks,

1 MNarne: 4D Se
- Publisher: 40

Path: Chprogram files (xG6) msupplyimsupply server
\msupply.exe

Allow 40 Server bo communicate on these netbworks:

Private netwaorks, such as my hame or wark network,

[ ]Public netwarks, such as thase in airports and coffee shaps (not recommended
because these nebworks often have little or no security)

What are the risks of allowing an apo throuah a Firewall?

G.ﬁ.llnw ACCEss Cancel

Allow mSupply to communicate on both private and public networks.

If the above steps have succeeded, you should see the 4D Server Administration window:
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& mSupply - [mSupply.4DC - 4D Server Administration] || B |
File Edit Window Help =[5 =

’t Maintenance

1 mn

System Information Hard drive Memory

Machine: SUSSOL-PC 233 GB 323 GE

System: Windows Seven Business Edition, 32-hi
Processor Intel[R] &tom(Th) CPU D510 @ 1.66GHz
IP Address: 192,165.3.220

Application information

Wersion: 13,2

Maximum connections

Application Server: 4 Data: 917 MB [} Used by 4D: 117 MB [}
SQL Server: Mone Others: 32 GB [} Others: 847 MB [}
Wieb Server: Unlimited Free: 140 GB [ Free: 2.29 GB [
SOAP Servert Unlimited
License Processors Metvrork
Mame: -
Used by 4D 2% Received: 4 kEfs
Licersed ta - Total: 2% Sent: 528 Bfs

Configure backups

e Select Maintenance and then, under the 'band' titled Last backup select Preferences.
o Scheduler: Set Automatic Backup: to Every day, at 20:00 or later, as long as it is a
time when work is likely to be finished. It will have to be set earlier, say 16: 00 if the
server is switched off of an evening.
o Configuration:
» Content:
tick Data File
untick Structure File
untick User Structure File
Delete all 'Attachments' except the .4DIndx file:
[JUser Structure File

Attachments: "mSupply. "g ADIndx" in volume “C:'
"m S upphy 9 AC :J, cData” involurme "C:"
""':'-'|-'f—' Y gl AL J_-, cHeader" in valume "C:"

* If this server uses the Dashboard, then add the dashboard configuration files
(normally C:\Progran Files\mSupply Dashboard\data\grafana.db
and C:\Program Files\mSupply Dashboard\conf\custom.ini) to the
backup - see figure below

e Add the 4D Index (.4DIndx) and journal (journal) files to the backup. They
should be in the same folder as the database. - see figure below
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Content

[ Data File
[ Structure File
[ User Structure File

Attachments: "grafana.db" in volurne "C:"
"custom.ini” in volume "C:"
S data.4DIndx

Delete Add folder... Add file...

e Backup File Destination Folder
o If on physical hardware, this should be a separate physical disk (e.qg.
D:\mSupply backups).
o If on a virtual machine, it is meaningless to have a separate physical disk, and it should
be C:\Users\Administrator\Documents\mSupply backups.
e Log Management: Set .journal to the same parent folder as the backups.
o If on physical hardware, this should be a separate physical disk (e.qg.
D:\mSupply journal).
o If on a virtual machine, it is meaningless to have a separate physical disk, and it should
be C:\Users\Administrator\Documents\mSupply journal.*

If a location of the log file is already specified, and you want
to change it, you need to untick the “Use Log” tick-box and

& then when you re-tick it you will be prompted for a new
location.

e Backup & Restore
o General settings
» tick Keep only last 15 backup files.
tick Backup only if the data file has been modified
Delete oldest backup file after backup
If backup fails: select Retry after 30 Seconds
tick Cancel the operation after 5 attempts.
o Archive
*= Segment Size (Mb): None
= Compression Rate: Compact
*» Interlacing Rate: None
= Redundancy Rate: None
e Automatic Restore
o tick Restore last backup if database is damaged
o tick Integrate last log if database is incomplete
e Click OK

You will see the following dialogue box:
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The log file will be activated after the next backup of the data file, Do you
wiant to start the backup automatically?

i;}

Cancel
e Click OK to create the first backup.

Configure cache

Edit > Database Settings > User settings for Data file

&+ mSupply _ 0 %
File | Edit Window Help

Undo Ctrl+Z

Server Administration EI@

Cut Ctrl+X 98 ¢ g [l |

Copy ST, “ :

Paste Ctrls rs (0) Processes (27) Maintenance  Application Server  5QL Server  HTTP Server  Real Time Monitor

Clear

Select All Ctrl+A

Show Clipboard

Preferences... Ctrl+,

Database Settings > Structure Settings..

User Settings...

User Settings for Data file...

CPU Usage =

3 Details
System Information Hard drive Memory
Machine: PNGO1 50GB 24 GB
System: Windows 10 Server or greater, 64-bit
Processor: Intel Core Processor (Broadwell)

IP Address: Any

Application information

Version: 17 build 17.228509 64-bit

Volume Shadow Copy: Up and running

Maximum connections Data: 3GE ] Used by 40: 173 MB [ |
App. Server: 15 (0 Used) Others: 2GB | Others: 2.4 GB [ |
50L Server: None Free: 40 GB | ] Free: 21.43 GB ]
‘Web Server: Unlimited
SOAP Server: None Processors Network
License Used by 4D: 1% Received: 6 kB/s

Select Database and then set up the cache memory.

Tick Calculation of adaptive cache

Memory to be reserved for other applications and for the system: = 512 MB (default?)
Percentage of the available memory used for cache = 100%. According to the 4D v16.5
Database/Memory page, 'Percentage of the available memory used for the cache = 100% since
there is only one 4D Server application.' If other applications running on the server need
additional RAM, it should be added to the figure above.

Minimum size = 1,000 MB (default?)

Maximum size = can be set to any number, including greater than available RAM. If this number
is greater than the available RAM, 4D will adapt the size of the cache according to the actual
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available RAM,
e Flush Data Buffers every: 10 Minutes

File | mSupply - User Settings for Data file

0B O m o

Interface Database Backup Client-server Web saL PHP

Memory

Database Cache Settings

Calculation of adaptive cache

Mermory to be reserved for other applications and for the systerm: | 512 MB
Percentage of available memory used for cache: | 100 %
Minimum Size: | 1000 MB

Maximum Size: | 16000) MB

Physical Memory: 16383 MB
Current Cache: 2500 MB
Cache on Restart: 15871 MB

Flush Cache every: 2| Minutes v

e Click OK

* Exit 4D Server Administration window.

e Check that the settings.4DSettings file has been created in the
<DataFolder>/Preferences folder

Setting the server software to run as a service

If you haven't already done so, configure Interactive Services Detection.

The server should now be set to start automatically when the machine is turned on. This can be
accomplished by setting the server to run as a service. Choose File > Register Current Database
as Service.

- If the Register Current Database as Service option is
| greyed out, you are probably not running the mSupply

&% Server as Administrator. You need to quit the server and run
as Administrator.
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& msupply

ﬂ]E Edit ‘Window Help
Mewy 3
Dper... Ctrl+0
Dpen Recent *
Close Database... Ctrl + Shift+ AL+l
Clase Window Crl +uf
Close & Windows Chrl + 2t -+

Register Current Database as Service
Unregister Current Database

Unregister all Server Sepvices

Flush Data Buffers Ctrl +3hift+Alt+ 35
Backup...
Restore...
Quit Ctrl+0)

Once you have registered the Current Database as Service, Quit the 4D by clicking the close box on
the top right (or choose File > Quit from the menus). You will then be shown a disconnect window
something like this:

4D Server

(O Disconnect from Server in: 10 min.
() Wait for all clients to disconnect.

() Wait for active clients to disconnect.

(lgnore sleeping clients)

Message:

(@ Disconnect all clients and quit.

Cancel QK

Type 0 into the box, and click OK . The server will quit.
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Pin Services to the taskbar
It is important to be able to quickly observe the status of the 4D / mSupply Service. Therefore, we pin
Services to the taskbar:

e Click Windows icon

e Type Services

¢ Right-click the Services Desktop App
e Select Pin to taskbar

Configure mSupply Service settings

Click on Services in the task bar. You will be shown a window like this.

#h, Services o m

| action wiew |J4--h| |||§|J>l|l m
Tree I Marne £ | Descripkion | Skaktus | Startup Tywpe | Log On As | -
% Services (Local) : 5 m3upply Marual Localsystem
%Alerter Motifies sel,.. Manual LocalSyskern
%npplicatiun Marage... Providess... Marual LacalSysken
%Clipﬂnnk Supporks C,., Manual LocalSystem
%COWH Event System Provides a...  Starked Manual LocalSystem
%Cnmputer Browser Maintains a... Started Aukornatic LocalSystem
%DHCF‘ Client Manages n... Started Aukomatic LocalSwstem
%Distributed Link Tra.,.. Sends notif... Starked Aukormnatic Local3ystem .
%Distributed Transac,,, Coordinate.,, Started Manual LocalSyskern
%DNS Client Resolves a...  Started Autornatic LocalSystern
%Event Log Logs event,,, Starked Aukormatic LocalSystem
%Fax Service Helps vou ... Manual LocalSystem
%Indexing Setvice Manual LocalSystem
%Internet Connectio,..  Provides n... Mariual LocalSystem
%IF‘SEC Palicy Agenk Manages I...  Started Aukomatic LocalSwstem
% Logical Disk Manager  Logical Disk,.,  Started Aukomatic LocalTyskem
% Logical Disk Manage... Administrat, ., Manual LocalSystem
%Messenger Sends and ..., Started Aukomatic LocalSystem
%Net Logaon Supporks p... Manual LocalSystem
%Netrﬂeeting Remate... Allows adt, ., Manual LocalSystem
%Netwurk Connecktions  Manages o...  Starked Maral LocalSystem LI

Double-click on 4DServer: mSupply - fortunately it is usually the first item in the list!

You will be shown the 4DServer: mSupply service properties window. Change the Startup type in
the drop-down list to automatic (Delayed start).
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4D Server: m5upply Properties (Local Computer) x
General |ogOn Recovery Dependencies

Service name: 405 msupply

Digplay name: 4D Server: mSupphy

Description:

Path to executable:
C:%Program Files («36)'mSupplymSupply Server'mSupply exe s "C:'—-.P'n::g%

Startup type: Automatic (Delayed Start) ~

Service status:
Start Stop Pause Fesume

You can specify the start parameters that apply when you start the service
from here.

Cancel Aoy

Historically, on the Log On tab, the service has needed to be
configured to Log on as Local System account, immediately
below. However, since mSupply 3.85+ on Windows Server
2012+ and Windows 10 1803+ the service has had to be
configured to Log on as Administrator account, further
below.

L
-

Log on as Local System account
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4D Server: msupply Properties (Local Computer)

General LogOn | Hecuveryl Dependenciesl

2 x

Log on az:

% Local System account

W Allaw zervice ta interact with desktop

™ This account; I

Browse. . |

FPazzword: I

Confirm pazsword; I

¥'ou can enable or dizable thiz zervice for the hardware profiles lizted below:

Hardware Profile | Service |
Prafile 1 Enabled
Erble | Disable |
k. I Cancel | Apply |

e Make sure “Log on as” is set to “local system account” (or LSA for short)
e Make sure “Allow service to interact with desktop” is checked.

e Click OK to return to the list of services.

* Close the Services window

Log on as administrator account

With mSupply 3.85+ on Windows Server 2012+ and Windows 10 1803+ the service has had to be

assigned to “Log On” to an administrator account for mSupply service to start:
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7 Services (Local)

40 Server: mSupply Mam| 40 Server mSupply Properties (Local Computer) X |g
40 hd

Stop the service 7 | Genenl LogOn  Racovery Dapandencies o
Eestart the service v :
LA Log on as 7]

"E-"a' () Local System aecaunt o

= - amrvio b e wilh et =

" ovicE erack with desidap

LA - - =

_: A () This sccourt “WAdministrabor Browes .. CE

G i, <t

4 _aﬁ'!"ﬁﬂl'd EREEREEREEREERS |

L A L i

."_.:':.\‘-'u Confirm passwond sEEERENSERRRERS | ]

A ' o

A ct

1Y i

L8 i

."_._' B4 i

_‘El ]

X e
ELe ol
o C i
.:'__:':t' ci
;C ]
G| [ [
EC e o
i UM Lenss e Sl WD n e wCaliladd #m D Diinmionm LT FR - B mrn

Help the mSupply Server Service find the data file

i|\ If you have configured the mSupply service to Log on as an administrator account, the
£ following settings are likely not required.

Depending on the Windows version, the Local System Account may not have permissions to access
the mSupply data file if it is not in the default location (in the Admin user's Documents folder). To fix
this, the following steps are required:

Download PSTools to the server

Extract to C:\PSTools

Run the Command Prompt As Administrator

At the prompt, type cd C:\PSTools <Enter>

Type psexec -1 -s cmd.exe <Enter>

The PsExec License Agreement dialogue box may open. Click Agree

ok wNe
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PsExec License Dgreerment X
Y'ou can alzo uze the faccepteula command-ling switch to accept the ELILA.
L]
SYSINTERNALS SOFTWARE LICENSE TERMS
These license terms are an agreement between Sysinternals (a whally
owinied subsidiary of Microsoft Corporation) and you, Please read them.
They apply to the software you are downloading from Systinternals.cam,
which includes the media on which vou received it, if any, The terms also
apply o any Sysinternals
updates,
supplements,
Internet-based services, and W
Print Decline

7. A new Command Prompt window should open. In this new window, type whoami <Enter> You
should see the following: nt authority\system If you don't, something has gone wrong and
you need to close all Command Prompt windows and start again.

8. Type cd c:\Program Files\mSupply\mSupply Server <Enter>

9. Type mSupply.exe <Enter> The mSupply Server will open, prompting for the data file
location:

No data file was found for the database "mSupply.4DC". Do
you want to open an existing data file or to create a new
2 L) datafile?

A 4D database needs this file to store its data.

Cancel Create Open

10. Click OK. The Select a 4D Data File window will come up, immediately followed by the
Location is not available error message:
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i
Help
i
+ <« mSupply Server » Server Database » v O Search Server Database R
Organise Mew folder = ~ [H o
~
# Quick access MName Date modified Type
W Logs 25/06/2019 12:51 File folder
Preferences 9 File folder
Resources 04/ 1 File folder |
web_dummy T -
Location is not available >
WebFolder
e CAWINDOWS\system32'confighsystemprofilelDesktop is unavailable. If the location is on this
PC, make sure that the device or drive is connected or the disc is inserted, then try again. If
the location is on a network, make sure that you're connected to the network or Internet, then
try again. If the lecation still can't be found, it might have been moved or deleted.
i » Create
File name: ~ | 4D Data File (*.4dd;*.data) v| |

Cance'

11. Click OK on the error message window, and then select the correct datafile. The mSupply.4DC
- 4D Server Administration window should open.

12. <Ctrl>-Q to exit mSupply Server. Enter 0 for the time delay.

13. Close both Command Prompt windows

From now on the 4D server should start automatically when the machine is turned on. There is no
need to log-on to the machine.

Manually starting the mSupply Server Service

e To manually start the mSupply Server Service, double-click the “Services” shortcut you made
on the desktop, highlight the 4D server service, and click the triangular “start” button (looks
like a “Play” button on a media player)

If clicking the Start Service button results in the Error 1:
Incorrect Function, a registry edit (regedit) is necessary.
Please only do this if you are confident and familiar with
editing the registry. mSupply Support can help with this. Edit
registry value:

Hive: HKEY LOCAL MACHINE

Path:
SYSTEM\CurrentControlSet\Control\Windows

DWORD: NoInteractiveServices

Change value 1to 0

Once finished editing the registry, close regedit and return to
the list of services and start the ISD service. It should now
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start!

Test

Check that mSupply server is running correctly in Session 0:

1. If you don't see mSupply server on Session 0 - Get back to Services and check 4D server
properties:
o LogOn should be set as “Local System account”
o Enabled option “Allow service to interact with Desktop”
2. Check if any Error window is showing up and need a OK confirmation to continue.
3. Check if the datafile needs to be selected because it has changed folder.

Since 4D v17

Since v17 of 4D (the database engine underlying mSupply), when running mSupply as a Service,
logging on as the Local System Account (LSA, as described below), mSupply MAY no longer have
sufficient permissions to access the folder: C:\Program Files\mSupply\mSupply
Server\Server Database\Preferences\Backup

If this is the case, it will result in the following error (which can only be seen in Session0):

Rumtirme Error

Error when executing the method "* On Backup Shutdown” at line number
90

.
"—0 The document cannot be opened.

Permissions error. Attempt to open locked file for writing. (File: C:\Program Files\mSupply
\rnSupphy Server\Server Database\Preferences\BackupBackup XML)

Details Edit L= Ahan

Process 9 BackupProcess Sawve... Copy
Mo Description

=54 Permissions error, Attempt to open locked file forwmting. (File: C\Program Files\mSupphtm3upply .
5 Access denied CAProgram FileshrSupplyimSupphy ServefiServer Database\Preferences\BackupiBack
5 Access is denied.

< >

If this happens, it needs to be fixed. The Solution is to edit permission of Users to allow Full
control/Modify/Write to the Backup.XML file as shown here:
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Manually stopping the mSupply Server Service

e To manually stop the mSupply Server Service, first make sure clients are not connected, then
double-click the “Services” shortcut you made on the desktop, highlight the 4D Server service,

and click the square “stop” button (looks like a “Stop” button on a media player)

Manually starting the Service

Despite being configured so, the mSupply Service sometimes will not start when the server hardware
starts. The service can be started through the Services:

Services - |[O
File Action View Help
e E Ba= HE »mnwp
- Services (Local) O Tz (Local)
4D Server: mSupply Name - Description Status Startup Type Log On As ~

w40 Server: mSupply Automatic (D.. Local Syste..

E service o ActiveX Installer (AxdnstSY) Provides Us... Manual Local Syste... _
% Advanced Monitoring Agent Running  Autornatic Local Syste... =
‘. Advanced Monitoring Agen... Add-onser.. Running  Automatic (D.. Local Syste..
“ App Readiness Gets apps re... Manual Local Syste...

Creating a new data file or choosing a different data file

From this point there should be no need to revisit any of the above procedures to operate mSupply.
However, if you are testing, or starting a data file for a second organisation, you may wish either to
change the data file mSupply is using or to create a new file.

The mSupply program (the files named “mSupply.4DC” and “mSupply.RSR”) store the path to the last
data file used, and the next time mSupply is started, the previous data file that was open is opened
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again unless there is user intervention or the “old” data file has been moved to a new location.
To intervene, hold down the “alt” key as the 4D server starts up.

You will be shown the standard open/save window:

21x]
Lok in: Ia Dats j Lo £ E-
. webFolder
my_precious_data
Hiztary
" f,.-"-"
@
C
m)\
ty Docurments
File marme: Imy_precinus_data j Open
Filez of type: IData File [*.4dd) j Cancel |
A
.

To create a new data file, click the “New” button.

To select an existing data file, navigate to the file's location then click the “Open” button.

Installing mSupply Client

Needed: mSupply Client software of the same version (or relatively recent) as the mSupply Server.

e The mSupply server should run as a service on the
server computer - see above. If any user needs to use
mSupply on the server (not recommended, but

6 possible, and sometimes necessary) then they should
not be running the mSupply Server software. They
should run the mSupply Client software, which should
be made available to all user accounts.

OS date settings
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Generally, mSupply will interact correctly with the local OS in terms of date format. However, as OS
versions continue to evolve and handle dates differently, sometimes this does not work. We have
found that very occasionally, if the OS date format is set to DD-MMM-YY (e.g. 20 APR 2020) then
mSupply will not always handle the date well. It is recommended to set the system date to DD-MM-YY.

Obtain and run mSupply Client installer

You must be logged on as Administrator to install mSupply
Client with the correct permissions. Please consult your IT
support staff if you require assistance to achieve this.

e Once you have obtained the mSupply Client installer file, double click it to install.
The mSupply client will be installed in the folder C:\mSupply\mSupply client on your computer.
mSupply client installer also installs the following files and folders:

e A shortcut on the Desktop called mSupply client.
e A folder called “\4D\Network” in the Windows folder on the startup volume, which contains
network component files that need to be present for 4D to communicate over a TCP (and other

types of) network(s).

* No reports are installed on 4D client. Each time 4D
client connects to the Server, reports that have been
added or modified on the server are automatically
copied to the client.

- e Installers have been set up to overwrite existing files,
@ so reinstalling the software will restore any potentially
corrupted files to their original state. The installer will
not overwrite your data files, unless you have been
unwise enough to name your data file “example data”
2

-

and put it in the “example data” folder

For convenience, pin the mSupply client desktop shortcut to the taskbar.

If any other Windows users will use this computer to access
mSupply, it is worth copying the mSupply client desktop
shortcut to the C:\Users\Public\Desktop folder. This

: will place the shortcut on the desktop of each user. Each

g user will need to pin this shortcut from their desktop to the
taskbar.

The C:\Users\Public\Desktop folder is normally a
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hidden folder. You will likely need to make it visible).

Additionally, if this computer is primarily used for running
mSupply, then it is worth copying the mSupply client
desktop shortcut to the Startup folder. The actual folder

@ o0
name changes with Windows version “ so here are
instructions: How to Add Programs, Files, and Folders to
System Startup in Windows.

Starting the mSupply Client

Once the installation is completed, double-click the “start mSupply Client” shortcut on your desktop. A
window something like this should appear:

1" Connection to 40 Sencer >

Welcome to 4D
w

Recent Available Custom

Servers

mSUpEly BULLETTRAIN

D Dizplay this dialog at mext startup

Cancel

The window lists available mSupply servers on your network (there should be only one!) Click on the
server you wish to connect to.

e Once you have connected successfully, the mSupply
Client 'remembers' which Server you last connected to
and stores this in the Recent tab. Whenever you run
the mSupply Client, it will automatically connect to

& that server.

e If, mSupply Client cannot connect to the mSupply
Server, this window will pop up showing the Recent
tab. You can try choosing the server there.
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e If, for some reason, network settings have been
changed and you cannot connect from the Recent tab,
£ remember to look at the TCP/IP tab as well.

Clicking the “OK” button will take you to the mSupply password entry window. For new data files, the
password is userl for the first user in the list. Click on the first user, then enter the password and
click OK

mSupply Client software cannot see the mSupply Server?

Server is not visible?

e To make it easy for you to connect, mSupply Server
publishes details about available servers on a specific
port. It is quite possible that products such as “Zone
Alarm” and “Norton Personal Firewall” will block access

0 to this port and stop discovery of the servers. Contact
your system administrator if the list of available
servers is blank.

e Of course, it may be possible that the mSupply Server
service is not running. Check Services to establish that.

e Lastly, the Windows firewall may be blocking the
Server publishing it's presence - see below.

Configuring Windows firewall on server

The Windows firewall may need to be adjusted to allow the Client to receive Server identification.

From the 4D tech email list:

e When you launch 4D client, it broadcasts a udp
message on the subnet, requesting all 4D servers to
identify themselves.

e The UDP message is sent from a random port to a
destination port = 19813 (default)

e When responding, each 4D server replies with a UDP
unicast message from its address to the client's
address with source port = 19813 and destination port
= whatever port the client had used to broadcast.

e So in order to let the client receive the answer back
from the server, one has to punch a hole in the firewall
for all UDP packets with a source port of 19813.
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Manually configuring the mSupply client

Due to firewall or if you connect to mSupply server via a router, then you may need to enter in the IP
address on the mSupply Client custom setting window.

B | Connection to 40 Server 4

Welcome to 4D
u

Recent Available Custom

Mame and Address of a published 4D Server.

Database Mame mSupply

e accovniing

£ QCCouning. Company.com
or 192 121, 122 1238858
or: [2007:0db &85 3:0000:0000:8a.2e:0370: 7334]: 19873

| Farce the update of the local resources

] Display this dialog at nest startup

Cancel

The data base name is always : mSupply

If mSupply server is serving via the default port (19813) then simply enter in the IP address.
mSupply Server configuration
Register mSupply

The procedure is described earlier in “Preferences” chapter of the mSupply manual. See The Register
button

You will either have to phone or email the information to Sustainable Solutions to obtain a registration
code.

The registration code is keyed to your Organisation name
and the MAC address of the server. Changing either of these

& will require a new code, which we shall willingly provide. So,
take care when setting the Organisation Name!
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Configure mSupply preferences

Once registered, you may want to systematically to go through the mSupply Preferences and choose
appropriate settings, and particularly setting up the Secondary backups! Start here: Preferences >
General

Turn off web dashboard

If the web dashboard has been set up on the Primary Server, then the dashboard preferences will be
copied to the Satellite site datafile. In most cases, the web dashboard is not being used on the
Satellite site and it is an unnecessary interaction with the scheduler, so may as well be turned off:

Before v4.04:

1. File > Preferences... > Dashboard
2. Untick the 'We use the web dashboard'
3. Click OK

After v4.04, the dashboard is managed through the Admin page of the navigator:

1. Admin > Dashboard > Export Settings
2. Clear the Postgres Server entries
3. Click OK
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&= Dashboard EI@

Dashboard Reports Dashboard Tab Export Settingso

Postgres Server Clear these 9

Server |Ic|ca|hust| |
Port |5432 |
User |pc|5tgres |
Password | .......... |
Patabase Name |dﬂSthﬂrd | Test connection
Export Settings
Table Export
abbreviation J A
account O
Admitted_from O
aggregator
asset ]
asset_condition ]
asset_location O
asset_status I y
. =
< > Export

Concel 3

Turn off servers

The Primary Server runs one or more 'Servers'. The preferences controlling these will be copied to the
Satellite site datafile. In most cases, these servers are not being used on the Satellite site and it is an
unnecessary interaction with the scheduler, so may as well be turned off:

¢ File > Preferences... > Server
o Turn off any 'Servers'

Configure secondary backups

You should have already configured the primary backup. We recommend setting up a secondary
backup which will send a backup off-site using a service such as Dropbox. The frequency of this
depends largely on what bandwidth your site can afford. Each backup can easily get to GB sizes...:

e File > Preferences... > Backup 2
o Configure secondary backups
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Turn on Syncronisation

When you are finally ready to turn on synchronisation:

* File > Preferences... > Synchronise > Click to un-lock, enter code to edit.
o Set the Sync time interval to 1
o Click OK

Your installation of mSupply may have customisations made
/1. specifically for your work scenario. Please contact our
[ ]

2500 support staff on support@msupply.org.nz to manage these
customisations.

Configure label printer
If you are dispensing, you will need to set up label printer preferences

Upgrading to a newer version of mSupply

/= User Access Control, a feature of Windows 7, requires that
! " the undernoted steps are followed when you are upgrading
~ mSupply

In Windows 7 click Start Menu> Control Panel> User Accounts

Click 'Change User Account Control Settings'

In the window that appears move the slider to the bottom and hit OK

You will be requested to restart the computer - do so(!)

If you copied the files already (which wont work as the pseudo copy occurs) these copied files
should now automatically work

ke wh e

Graceful shutdown in the event of a power failure

Your mSupply server should be attached to a UPS. The UPS should be fitted with a control cable
(serial, USB or network cable) that allows control software to detect a low power situation and shut
down the server.

In the UPS control software set the shutdown to start at least two minutes before the power will fail.

Set it to run a batch file at that point. The file should contain the single line “net stop Service name”
where the service name is the name displayed in the properties when you double-click the service
name in the services window. In the example below the service name is “4DS mSupply.4DC” (not to
be confused with the display name)
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Service name; 405 mSupply 40C

Dizplay name

D escription: |
You may wish to test your typing skills by opening a command prompt:

E:"-.,WINNT"-.,535I:em32"-.,|:n1d.e:|-:e

Microsoft Windows 2888 [Uersion 5.868.21951
C(C» Copyright 1985-1999 Microsoft Corp.

C:s>net stop "4DS mSupply.4DC'
The 4D Server: mSupply service iz stopping...
The 4D Server: mSupply service was stopped successfully.

Cosr

Accessing a cloud hosted server

Access to a cloud hosted mSupply server is through the Windows Remote Desktop Protocol.

Windows client

If the mSupply client software is running on a PC, there are a range of applications that can be used
for accessing the cloud hosted mSupply server including Microsoft's own Remote Desktop Connection
software that comes included with Microsoft Windows. There are third party implementations that
provide additional security and controls. One that we are currently (2016) finding effective is TS-Plus.

Macintosh client

Access to the the Microsoft Remote Desktop App is available on the Apple Store:
https://itunes.apple.com/en/app/microsoft-remote-desktop/id7157684177mt=12

e The Display Name is the name that will appear on your computer. We suggest you make it:
mSupply Remote Access

e The Computer Name is the name of the domain name of the mSupply server computer that you
are connecting to.

Previous: 25.02. mSupply client / server installation part 2 | | Next: 25.04. Schedules and
periods
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